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Introduction. 

Welcome to ArtRage 2.5.

This manual covers all of the features of the application and tells you what you need to know to get 

painting. The section titled ‘The Basics’ tells you how to use the interface and go about creating 

your paintings. The rest of the manual covers all of the settings and features in detail. This manual 

is for the full version of ArtRage.

We've also included some extras in the installer. You'll find some sample tracing images, extra paper 

grains, and custom color pickers that show you the kind of thing you can do with them. You will 

also find a set of Stencils and Rulers for use with the Stencils system.

This version of ArtRage includes the ArtRage Auto Updater, which allows you to easily update your 

product online with a few simple button clicks.

If you want to learn more about using ArtRage, visit the ArtRage Forums online and join in the 

discussion. Once you've registered, you can find tutorials, galleries, and support if you need it. 

Thanks for purchasing ArtRage 2, we hope you have a great time painting!

http://www2.ambientdesign.com/forums
http://www2.ambientdesign.com/forums


The Basics. 

This chapter tells you everything you need to know about getting started with ArtRage 2 including 

where you can find things in the interface, and how to create your own paintings.

The Interface. 

When you open ArtRage 2, you’ll get a window that looks something like this.

While you’re working in ArtRage, that window is both your easel and your tool box. It has number 

of handy controls that can be used while painting, and a canvas that fills the entire window.

At the top of the window is the menu bar. Here, you’ll find options for your painting, printing, sav-

ing, loading, and settings for your canvas. You’ll also find Undo and Redo, and controls for setting 

the size of the window.



At the bottom left of the window is the tool picker. Here, you’ll be able to select which tool you’re 

using to paint with, and control how big it is.

At the bottom right of the window is the color picker. Here, you’ll be able to select which color 

you’re painting with, and load in custom color pickers when you need them. If the tool you have 

selected can get dirty (like an oil brush), you’ll see a glass of water too, for cleaning it off.

On the bottom edge of the window is the Toolbox Panel. This panel is like a tray that contains all 

the tools that do things with your canvas, rather than painting tools. You can use it to move, rotate, 

and zoom the canvas. You can also use it to load in Tracing Images, Reference Images, and get ac-

cess to your Stencils.



Stuck to the left edge of the window is the Tool Settings panel. When you have selected a tool in the 

Tool Picker, this is where you go to change any properties it may have, like how thin your paint is.

On the right hand edge of the window is the Layers panel. this panel lets you work with the layers 

in your painting, adding new ones and selecting which one is currently active.

Other panels will appear as you’re using the application, they’re explained later on in the manual. If 

you just want to get in and paint immediately, all you need to be able to find are the Tool Picker and 

the Color Picker.



Using the Interface. 

The ArtRage 2 interface has a variety of controls that perform common operations. This section 

takes a quick look at some of the shortcuts you can take when using them.

Grips and Movable Panels. 

Any panel that has a grip can be retracted in to the side of the screen. Click the grip and the panel 

slides in. Click it again and the panel slides back out.

Panels that are on the edge of the screen (the Toolbox, Swatch Pane, Tool Settings Pane, and Menu 

Bar) can be dragged along their edge to move them. Click and drag the grip and you can reposition 

the pane.

Dials. 

When you need to set a value in ArtRage you use a Dial. Dials let you click and drag in their circu-

lar area to set their value. The little grey wedge at the top is used if you want to set the value to 

100% or 0% quickly, click in the right hand area of it to set the dial to 0%, or the left hand area to 

set it to 100%.

If you click in the central circular area of the dial (where the number is), you’ll get a text entry that 

lets you set the value numerically. Press OK to accept the change you’ve made, or Cancel to discard 

it.

If you click and drag up and down in the central circular area (where the number is), the value will 

change, this is for if you find it hard to drag in the circular region.

If you want to enter the value by hand, just click the central circular area (where the number is) 

without dragging, and a number entry box will pop up.

Tip: If you click and drag in the circular area of the dial, you can make the value adjustment more 

accurate by moving the mouse pointed away from the centre of the dial and dragging in a bigger 

circle.



Floating Color Pickers. 

Some panels in ArtRage, such as the Paper Settings panel, let you select a color. Where you see a 

color sample you have two options:

• When you click and drag around, a color picker appears and you can select color from it. Release 

the mouse to apply the selection

• When you click and release the mouse button, a color picker appears with an OK and Cancel but-

ton and you can select color by clicking inside the color samples. 

In the top right of the Floating Color Picker is a small circle that contains the default color. Click in 

there, or drag to it and release the mouse over it, and the color will be selected

In the top left of the Floating Color Picker is a small circle that contains a dial. Click in that, or drag 

to it and release the mouse over it, and a Numeric Color Picker will appear that lets you enter accu-

rate color information.



Creating and Saving Paintings. 

When you open up ArtRage you will already have a canvas as big as the screen ready for painting. 

You can create new paintings, save your paintings, or export them in a format that other packages 

can understand.

Creating a New Painting. 

To create a new painting, select the New Painting option from the File Menu, or press N. When you 

do this, the New File panel appears.

This panel lets you set the size of your new painting, tell it to load a tracing paper if you wish, and 

set up the properties of the paper you’re going to be painting on.



In the Canvas Size pane you can set the dimensions of your new canvas. Enter the size you wish to 

use in the text entry boxes.

If you wish to make a canvas as big as the screen (which is the default option), press the Use Screen 

Size button. If you have told ArtRage you want to use a tracing paper in the image and you wish to 

use the size of that tracing paper, press the Use Tracing Paper Size button.

By clicking the ‘pixels’ button you can change the units ArtRage uses to calculate the size of your 

painting. You can select from pixels, inches, centimeters, and millimeters.

By changing the dpi value, you can adjust the print resolution of your painting if you wish to meas-

ure it for printing.

The Preset Sizes button opens a menu that contains predefined sizes you can use, and allows you to 

reset your painting’s size if you are not sure of the current settings. Using this menu you can also 

store your current settings as a preset for access later.

Tip: Don’t forget that you can always select the Reset option from the Preset Sizes menu if you are 

not sure what the settings mean.

In the Tracing Paper pane you can tell ArtRage to load a tracing paper to use in the new painting. 

Click the Load Tracing Paper button to load a paper. If a paper is loaded, that button becomes a 

Clear Tracing Paper button to clear it.



In the Presets pane you can select a preset canvas type to use for your painting. We’ve included a 

number of different canvas types (from real canvases, to paper types). To select one, click the image 

of the one you wish. If you click the Previous or Next buttons, you can browse through all of the 

presets you have.

When you select a canvas, a big preview of it is updated beneath the preset images. If you wish to 

add your current canvas settings as a new preset, click the Make a New Preset button and enter a 

name.

In the Settings pane you can set all of the properties of your new canvas.

The leftmost control is the Grain control. Click it to select a type of canvas grain to use, the Grain 

Picker will appear.

There are three standard Grains, which can be selected with a click, or you can load an image to use 

instead if you prefer. If you decide not to change the Grain, click Cancel in the Grain Picker.

The Roughness dial lets you change how rough your grain is, the higher the value the deeper the 

grain. The Scale dial lets you change how big the grain scale is, the higher the value the larger the 



size of the dents. The Opacity dial lets you change the opacity of your paper. The lower the value, 

the more transparent it becomes. The metal dial lets you control how metallic your paper is. The 

higher the value, the more metallic the paper looks.

The Color Sample at the far right lets you select a new color for your canvas. Click it to open a 

Floating Color Picker, or click and drag to select a color without having to click OK to accept.

Finally, click OK to create the new painting, or Cancel if you decide not to.

Saving or Exporting a Painting. 

To save your painting, use the Save Painting option in the File Menu. When you save an ArtRage 

painting it is saved using the .ptg format, which contains all the information on the layers and paint 

that you have created so far.

If you wish to save your painting in a form that can be read by other applications, you can use the 

Export as Image option in the File Menu. That allows you to save your painting as a JPEG, PNG, 

BMP, or Photoshop format file. If you have used multiple layers, saving as any format except Pho-

toshop will flatten your image down to one layer in the exported version. The painting in ArtRage 

will still have all its layers.

Tip: If you have created a painting with multiple layers, exporting as a Photoshop file keeps those 

layers intact. If you have created a painting that has a transparent bottom layer, saving as a PNG or 

Photoshop file will retain that transparency. Jpeg and BMP files fill in transparent areas with paper 

color and texture when you export.

Importing an Image. 

If you have an image you would like to load in to ArtRage to work with, you can use the Import 

Image option in the File Menu. When you select this option you are given the opportunity to load in 

a Jpeg, BMP, PNG, or Photoshop document that will appear inside ArtRage.

When you import an image, the image is imported as if made out of Oils, so you can smear it using 

the Palette Knife or other tools that interact with wet paint.

Tip: If you import a multilayered Photoshop file, ArtRage keeps the layers intact. We support stan-

dard pixel layers in the Photoshop 5 format, which can be saved by all versions of Photoshop from 

5 upwards. Special layers will be ignored on import.



Printing a Painting. 

If you would like to print your image, select the Print option from the File Menu. On the PC, when 

you select this, a print window appears and from there you can start printing. On the Macintosh, to 

adjust your page settings, select the Page Settings option from the File Menu and change settings 

there before printing.

When you create or resize your paintings, you are given the option to set their ‘dots per inch’ value. 

This value is used by your printer to determine how large the painting should be printed. If you 

want to create a painting of a certain size when printed, set the size in inches when you create it, 

and set the dpi value to the value you will be using to print.



The Tool Picker. 

The Tool Picker can be found at the bottom left of the ArtRage window. It lets you select which tool 

to use and how big a stroke that tool should apply.

Selecting Tools. 

The Tool Picker at the bottom left of the Canvas allows you to select the tool you wish to use for 

painting on your canvas. The Tool Picker has a button for each of the tools, and a Tool Size control 

that lets you change how large the tool is.

To select a tool, click its button in the Tool Picker. The tools in the picker appear as follows, from 

left to right: 

• Outer Row: Oil Brush, Pencil, Palette Knife, Airbrush.

• Middle Row: Chalk, Glitter, Paint Roller, Paint tube.

• Inner Row: Color Sampler, Felt Pen, Crayon, Eraser.

Setting Tool Size. 

To set the size of a tool, click and drag in the Tool Size control which is at the bottom left corner of 

the Tool Picker.

Drag to the right to make the tool larger, or the left to make it smaller. If you wish, you can also use 

the + and - buttons at its edge to fine tune the size. If you wish to enter a value directly, click the 

size preview and a text entry box will appear allowing you to enter the precise size you wish.



The Tools.

This section looks at each of the 12 painting tools available in ArtRage.

Some General Rules for Paint. 

ArtRage attempts to simulate real world painting, and so there are some general rules that apply to 

all the paint you use on your canvas.

Smearing. 

You can only smear when there is paint to smear. Imagine putting a really thick stripe of toothpaste 

on a canvas. When it’s thick you can spread it a long way, and as you spread it it gets thinner until 

eventually you can’t spread it any further. ArtRage works the same way.

If you have a lot of paint on your canvas (the Oil Brush and Paint Tube are good for leaving lots of 

paint on the cavas) you can smear it a long way. The Oil Brush will smear paint as it is used, so will 

the Palette Knife. As you smear you’ll see that the paint thins out and eventually runs out on the 

canvas. When it’s run out, it’s too thin to smear again so you should add more paint.



If you try to smear where there’s nothing to smear, such as over a chalk stroke, you’ll get a smudg-

ing effect instead.

Wetness. 

ArtRage lets you apply wet pens to your canvas. The wetter the pen, the more ink is applied and the 

more color it will pick up as you stroke.

If you use really wet pens you can see that the ink color changes because it’s wetting the color be-

neath and carrying it with the stroke.



Dryness. 

Sometimes you’ll want to paint on to paint that has already dried. Doing this means that the paint 

you apply won’t smear or blend with the paint beneath, it’s dry so there’s nothing to blend with. The 

easiest way to do this is to add a new Layer and paint on that instead. That means that you won’t 

mix with the paint below at all, and you can still go back to the earlier layer and paint in it if you 

wish to (it’s like painting on transparent plastic in front of your canvas, you can always go back to 

the layer beneath if you want to change it).

You’ll notice that if you paint on a new Layer the lumpiness of the paint you applied beneath is still 

visible. The stroke we painted across the top here hasn’t blended at all but you can see the texture of 

the stroke below because it’s just like you’re painting over it on a real canvas.

Tip: The Oil Brush as an Insta-Dry option that will make every stroke of paint dry as you apply it 

so you don’t need to add another layer.



The Oil Brush Tool. 

The Oil Brush tool gives you a paint brush that can be used to paint with a variety of different styles 

of oil. With the new Thinners setting you can adjust how lumpy the oil paint is and get a range of 

results from thick, dry paint to thin, easy to spread paint. If you’re just playing around with paint for 

the first time, try some nice thick oils and see how they smear!

The Oil Brush has the following properties: 

• Smearing: Wet oils will smear as you use them, so if you paint a stroke over a previous stroke 

and there is paint to smear, you’ll get some color blending.

• Running Out: Oil paint runs out on the brush so you’ll find that if you make long strokes, the 

paint will run out on the canvas.

• Color Dirtying: The Oil Brush remembers the color you last touched on the canvas, and when 

you go to paint it can blend that with the color you’re trying to apply if the head is still dirty.

• Volume: Oil paint has volume, that is to say it leaves a thick paste on the canvas. You can see this 

because the bristles leave stripes through it. If there’s thick paint on the canvas, you can smear it 

with the Palette Knife or by stroking over it with the Oil Brush.

When you select the Oil Brush, the following settings become available: 

• Pressure: The amount of pressure the Oil Brush applies. If you are using a mouse or tablet with 

no pressure sensitivity, this adjusts the level of pressure the Oil Brush assumes. If you are using a 

tablet with pressure sensitivity, it adjusts the amount of pressure the tablet applies, giving you a 

heavier or lighter range of strokes.

• Thinners: The higher the level of Thinners, the thinner the paint becomes. With lots of thinners, 

your paint isn’t as thick on the canvas and it will go further before you need to refill the brush. 

Don’t worry, ArtRage won’t run out of a color if you need to keep refilling.

• Loading: The amount of paint you’ve loaded on to the brush head. The higher the loading, the 

more paint there is so the further it will go before running out. If you’re using no Thinners and 

you want a long stroke, set your loading really high.



• Insta-Dry: If this is On all your paint strokes will dry as soon as you apply them. That means you 

can’t smear your paint.

• Auto-Clean: If this is Off your brush head will not be cleaned at the end of each stroke and any 

color you picked up in your stroke will remain there when you start painting again. In this case, a 

glass of water appears beside the Color Picker at the bottom right so that you can clean the brush 

yourself if you want.

Thinners let you create a variety of different types of oil paint.

The top stroke has no thinners, the middle stroke has 50% and the bottom has 100%. Notice that the 

bristles leave less of a pattern as we add more thinners, the paint gets wetter. If you use the Palette 

knife on the top stroke you can smear quite a long way because there’s a lot of paint there. If you 

use it on the bottom stroke you can’t smear very far at all, the paint is too thin. The Thinners control 

can make your oil paint thin enough to become transparent. If you take Thinners about 50%, you'll 

start to see the paint thin enough that you can see through it.

Paint will smear itself and blend colors as you use it. In the image below we crossed two strokes of 

thick paint (0% Thinners) to show this.



The Pencil Tool. 

The Pencil Tool gives you a range of pencils that you can draw with. By adjusting its settings you 

can make it hard or soft, and even change the angle at which you’re holding it. The pencil is good 

for precision drawing, outlining, or even light shading as it uses the pressure value of your stylus to 

great effect if you have one.

The Pencil Tool has the following properties: 

• Dryness: The Pencil is a dry tool, it doesn’t smear.

• Hardness: The tip of the Pencil is hard, so if you use it really lightly (if you have a pressure sen-

sitive tablet) you’ll see it doesn’t apply much, you press harder and it applies more. This also 

means that it cuts through the volume of paint if you draw over it.

• Shape: The lead of a pencil is conical in shape, so if the pencil is tilted you get a wider stroke.

• Smudging: Because it’s dry and doesn’t leave much actual pigment on the canvas, the pencil 

can’t be smeared. It can, however, be smudged. Use the Palette Knife for smudging.

When you select the Pencil, the following settings become available: 

• Pressure: The amount of pressure the Pencil applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the Pencil assumes. If you are using a tablet 

with pressure sensitivity, it adjusts the amount of pressure the tablet applies, giving you a heavier 

or lighter range of strokes.

• Softness: The softness of the pencil lead. Soft leads tend to be darker because more of the pig-

ment breaks off as you use them. Hard leads give you more accurate strokes.

• Tilt Angle: How far the head of the pencil is tilted over. The higher the tilt value, the thicker the 

stroke because you’re using more of the lead.

• Precise: Indicates whether the pencil is in ‘Precise’ mode. When in this mode, the pencil strokes 

are much sharper and firmer, they do not break up as much on your canvas.



Changing the softness of the Pencil gives you a variety of different pencil types. A hard pencil such 

as a 6H would have a softness around 0%. A soft pencil such as a 6B would have a softness around 

100%.

If you want to do soft shading with the pencil, take the Tilt Angle value up. The higher this value, 

the ‘flatter’ the area being used to draw with so you get a much softer result.

That stroke was produced with a pencil with a Tilt Angle of 100%, used lightly and ‘scrubbed’ back 

and forth repeatedly to slowly build up shade.

The right hand stroke was produced with a precise pencil. The result is a much smoother stroke re-

gardless of the grain on the canvas.



The Palette Knife Tool. 

The Palette Knife Tool gives you a flat bladed knife that can be used for smearing paint around, or 

smudging color when you don’t have much to smear. If you have lumpy strokes that you want to 

smooth, or even if you just want to blend some colors together, use the Palette Knife. If you’re just 

learning about paint, try using the Paint Tube tool to lay down two thick strokes of different color, 

and then using the Palette Knife to smear them together to mix. The Palette Knife can be a great 

tool for creating textures in your paint.

When you select the Palette Knife, the following settings become available: 

• Pressure: The amount of pressure the Palette Knife applies. If you are using a mouse or tablet 

with no pressure sensitivity, this adjusts the level of pressure the Palette Knife assumes. If you are 

using a tablet with pressure sensitivity, it adjusts the amount of pressure the tablet applies, giving 

you a heavier or lighter range of strokes.

• Blending Type: There are three types of blending available to the Palette Knife. ‘Flat’ works as if 

the knife blade was flat and creates an even blend. ‘Edge’ works as if you were tilting the knife so 

that the edge scrapes the canvas more. ‘Soft’ creates smooth blends that merge paint more 

smoothly.

The Palette Knife lets you smear paint and smudge other types of media. When there’s something to 

smear, it smears it. When there’s nothing to smear but something to smudge, it smudges it. The dif-

ference is in the type of thing you’re using the knife on. If you’ve used the Tube to lay down a long 

stripe of paint, the knife has lots to smear so you can smear it around. If you’ve done some pencil 

sketching, the knife can’t smear anything but it can smudge the pencil lines.

Tip: Some tools in ArtRage (such as the Glitter Tool) apply dry paint that can’t be smeared. How-

ever, if you add a tiny bit of wet paint next to a dry stroke, and use the knife to smear the wet paint 

over the dry, the two blend and you can start to smear the dry as well. This can create some great 



The differences between the three types of knife blending are illustrated above. Flat on the left 

smears with the flat of the knife. Edge in the middle uses the edge to scrape the paint. Soft on the 

right blends smoothly with a soft blending head.

The Airbrush Tool. 

The Airbrush Tool gives you a fine nozzle spray tool that can be used to apply thin coats of paint to 

your canvas. Like a real airbrush, this tool seems simple at first but can be used to create a huge 

range of effects. By changing how fast the spray flows, the angle it sprays at, and even a tapering 

effect, you can produce all sorts of interesting results. The Airbrush Tool is particularly good at ap-

plying consistent strokes of thin paint without smearing, smudging, or altering the paint it is applied 

over in any way but color. So, if you ever want to change the color of something you’ve applied, 

this is the tool to use.

The airbrush has the following properties: 

• Dryness: The Airbrush applies a very thin layer of paint that dries really quickly. When you use 

the Palette Knife on it, it smudges the result. This can be used to dry paint that was previously 

wet.

• Shape: The Airbrush watches the tilting of your tablet stylus if your tablet supports tilt. The more 

the tilt, the more extended the shape of the spray becomes. If you hold the stylus upright it pro-

duces a circular result, as you tilt the result becomes more conical.



• Flow: The Airbrush can be set to produce a continuous spray even when you’re not moving. If 

Autoflow is on, the Airbrush will spray more and more paint on to the canvas as you hold still. If 

it is off, the Airbrush will only spray while you are moving.

• Flow Speed: The Pressure setting of the Airbrush controls how fast the spray flows. The harder 

you press, the faster it goes.

• Tapering: The traditional Airbrush ‘knife stroke’ can be achieved using the Tapering control. 

Knife strokes taper to a point at the end.

When you select the Airbrush, the following settings become available: 

• Pressure: The amount of pressure the Airbrush applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the Airbrush assumes. If you are using a tab-

let with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the 

Pressure, the faster paint is applied.

• Tilt Angle: Controls the basic level of tilt the Airbrush applies. If you are using a mouse or tablet 

with no tilt sensitivity, this adjusts the level of tilt the Airbrush assumes. If you are using a tablet 

with tilt sensitivity, this adjusts the amount of tilt the tablet applies. The higher the tilt, the more 

conical the spray becomes.

• Taper Length: The Airbrush allows you to create tapered ‘knife strokes’. By setting the value of 

this control to anything other than 0% you set how far the stroke goes before the taper happens.

• Autoflow: Controls whether the Airbrush spray flows while you are moving or not. If this is On, 

the Airbrush will continue to spray while you hold still. If it is Off, you need to move the Airbrush 

to get paint flowing.

Tilt Angle is great for creating nice shaped strokes. In the image below, the leftmost spot was made 

with a mouse and 0% tilt, as the spots progress to the right, the tilt level was increased. By the time 

we get to the far right, the spot is more oval than circular, and extends further away from the centre 

point.

When you’re using the mouse, the direction of tilt is defined by how you move. In the image below 

I dragged in an counterclockwise circle, notice how the centre of the circle has a well defined line, 

while the outside is fuzzy, that shows that the Airbrush was tilting away from the centre as I moved.



Taper Length is used to create ‘knife strokes’ that get thinner over time. The Taper Length value set 

to 0% causes no taper, but anything greater makes the stroke trail off. The stroke won’t taper unless 

you’re moving, so even if you hold the Airbrush on the same spot with Autoflow on for a while, it 

won’t start tapering until you move. In the image below, the top stroke has no taper, and we in-

creased it with each stroke down.

Autoflow can be used to create dark spots of color with harder edges. In the image below, Autoflow 

is on and with each spot progressing to the right we held the cursor still for longer. The Pressure 

was set quite low to slow the flow down and make it more obvious what the effect was. If you have 

high pressure, holding for even a short time with Autoflow On will create hard edges.

Notice how the spots get larger as they go to the right? The brush size was the same for all of them, 

but as more paint is applied the dark area in the middle gets bigger.

Tip: If you have lumpy paint on your canvas and you want to change its color, use the Airbrush, it 

applies color without changing any of the volume of paint on the canvas. If you want to make a sur-

face Metallic, turn on the Metallic paint option and use the Airbrush, it applies a nice smooth coat to 

things.



The Chalk Tool. 

The Chalk Tool gives you a stick of chalk for use on your canvas. This tool is a simple tool, but it 

can create some subtle effects if you use it lightly on a rough surface. If you want to bring out the 

texture of the paper you’re using, this is a great tool for the job.

The Chalk Tool has the following properties: 

• Dryness: Chalk is a dry tool so it doesn’t smear, but it will smudge if you run the Palette Knife 

over it.

• Hardness: The tip of the Chalk is hard, so if you use it really lightly (if you have a pressure sensi-

tive tablet) you’ll see it doesn’t apply much, you press harder and it applies more. If you press 

lightly, you’ll only leave chalk on the bumps in the canvas, not the dents.

When you select the Chalk Tool, the following settings become available: 

• Pressure: The amount of pressure the Chalk applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the Chalk assumes. If you are using a tablet 

with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the Pres-

sure, more chalk is applied, filling in the dents in the canvas.

Pressing harder with the Chalk Tool, or increasing its pressure, makes more of it apply to the can-

vas. In the image below, we started with light strokes and moved on to heavier as we applied more.



The Glitter Tool. 

The Glitter Tool gives you a tube of glitter that can be sprinkled on to the canvas. This takes the 

form of sparkly dust that gathers to create a trail along the path of your mouse or stylus. You can 

sprinkle it quickly or slowly, and let it build up in to big piles if you like. Glitter works particularly 

well if you turn on the ‘Metallic’ check box in the Color Picker so that it applies metal dust. If you 

don’t use Metallic with glitter, you can get some good grainy results. Glitter’s great for people who 

want to play around with the kind of pictures most of us used to do at school, but it can also be used 

to create some rather nice textures.

Glitter has the following properties: 

• Dryness: The Glitter Tool applies dust that is dry when it lands. When you use the Palette Knife 

on it, it smudges the color but not the lumpiness.

• Auto-Sprinkle: The Glitter Tool produces a continuous sprinkle even when you’re not moving. 

This means you can build up piles of it by holding in one location.

• Flow Speed: The Pressure setting of the Glitter Tool controls how fast the glitter sprinkles. The 

harder you press, the faster it goes.

• Shape: You can select the shape of glitter to be sprinkled, from a choice of 4.

When you select the Glitter Tool, the following settings become available: 

• Pressure: The amount of pressure the Glitter Tool applies. If you are using a mouse or tablet with 

no pressure sensitivity, this adjusts the level of pressure the Glitter Tool assumes. If you are using 

a tablet with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher 

the Pressure, the faster the glitter is sprinkled.

• Glitter Size: Controls the size of the particles of glitter dust that are applied. The larger the size, 

the larger the sprinkles and you can end up with some truly monstrous glitter!

• Glitter Shape: Controls the shape of the glitter to be applied.

• Multicolor: Controls how careful our staff were when putting the leftover glitter back in its pot, 

the higher the value, the more colors of glitter come out at once. If you set this value to 0%, your 

glitter will be one color, but as you increase the value, more colors start to appear.

The Glitter Tool can be used for a wide range of effects. It can be used to create some simple im-

ages with a bit of sparkle, but it can also be used to add texture to your paintings. Turning off the 

Metallic checkbox in the Color Picker when using Glitter gives you a result that looks more like 

grainy paint. The effect can be adjusted by changing the Glitter Size dial.



!

The shape of the Glitter can be changed to give different effects. You can choose from Square, Cir-

cle, Ball, Grit, and a random selection from all of those.

!

The Paint Roller Tool. 

The Paint Roller Tool gives you a hard surfaced roller that can be used for applying large, smooth 

strokes of paint to your canvas. If you want to quickly block in a large area with color, or even just 

apply a flat stroke of paint without any bristle texturing, this is the tool to use!

The Paint Roller has the following properties: 

• Smearing: The roller applies paint that will smear as you use it, so if you paint a stroke over a 

previous stroke and there is paint to smear, you’ll get some color blending.

• Running Out: The roller runs out of paint over time.

• Color Dirtying: The Roller remembers the color you last rolled over on the canvas, and when 

you go to paint it can blend that with the color you’re trying to apply if the head is still dirty.



• Smoothness: The roller is for applying smooth strokes of paint to the canvas, so its leaves behind 

a stroke that has no bristle lumps or other roughness.

• Size: The Paint Roller can go larger than any of the other tools in ArtRage, so it’s great for apply-

ing large areas of color quickly.

When you select the Paint Roller Tool, the following settings become available: 

• Pressure: The amount of pressure the Paint Roller applies. If you are using a mouse or tablet with 

no pressure sensitivity, this adjusts the level of pressure the Roller assumes. If you are using a tab-

let with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the 

pressure, the more firmly the roller pushes against your canvas so the thinner the paint becomes.

• Thinners: The higher the level of Thinners, the thinner the paint on the roller becomes. With lots 

of thinners, your paint isn’t as thick on the canvas and it will go further before you need to reload 

the roller by starting a new stroke Thinner paint will tend to produce more mottled strokes.

• Loading: The amount of paint you’ve loaded on to the roller. The higher the loading, the more 

paint there is so the further it will go before running out. If you’re using no Thinners and you 

want a long stroke, set your loading really high.

• Auto-Clean: If this is Off your roller will not be cleaned at the end of each stroke and any color 

you picked up in your stroke will remain there when you start painting again. In this case, a glass 

of water appears beside the Color Picker at the bottom right so that you can clean the brush your-

self if you want.

If your tablet supports pressure, remember that the paint roller leaves the best strokes if you don’t 

press too hard. The harder you press, the more the paint is squeezed out of the way by the roller 

head, so you get a mottled look to your stroke.

Tip: Because of the way it works with pressure, the Paint Roller can be used to remove paint from 

the Canvas. Just press really hard as you use it and you’ll see it picks up paint from below where it 

can.

The Paint Tube Tool. 

The Paint Tube Tool gives you a big tube of paint that can be squeezed out on to your canvas to cre-

ate some really thick strokes. The Paint tube isn’t necessarily a tool for applying strokes, it’s more a 

way to get lots of paint on to the canvas rapidly so that you can blend it with other paint or create 

textures using the Palette Knife. It’s also great fun. If you just click to apply a spot of paint rather 

than a stroke, you can get some interesting textures too.



Strokes made by the Paint Tube have the following properties: 

• Wetness: Strokes made by the Paint Tube are wet and have lots of paint in them so you can smear 

them easily.

• Thickness: The Paint Tube applies thick paint that doesn’t mix with other colors while you’re ap-

plying it.

• Never Runs Out: The Paint Tube never runs out while you’re using it.

When you select the Paint Tube tool, the following settings become available: 

• Pressure: The amount of pressure the Paint Tube applies. If you are using a mouse or tablet with 

no pressure sensitivity, this adjusts the level of pressure the Paint Tube assumes. If you are using a 

tablet with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the 

pressure, the flatter the paint tube’s stroke becomes. If you apply with low pressure, the stroke is 

thin and rounded, but it flattens out and gets ripples as you press harder and the tube mouth 

touches the stroke.

The Paint Tube is a simple tool, and much of the time it will be used only to prepare paint for later 

use. If you try applying it in spots, by single clicking, you can get some interesting textures. Pres-

sure changes the look of the single spot as you apply it.

The leftmost spot is with very light pressure, the rightmost is with heavy pressure. The mouth of the 

tube has dipped in to the paint as I press harder and created a ring in the spot.

The Sampler Tool. 

The Sampler Tool does not create paint strokes, rather it is used to choose colors by sampling them 

from your canvas. When you select the tool you can then click and drag over your canvas to sample 

colors from wherever you like. The Color Picker updates while you are sampling, to show you the 

result.

When you select the Sampler tool, the following settings become available: 



• Single Layer: If turned ON, this means that the sampler will only pick up color from the layer 

you are currently working on. If turned OFF, the sampler picks up color from all layers.

• With Lighting: If turned ON, this means that the sampler picks up the color you see on the 

screen. If turned OFF, it means that the sampler picks up the color of the paint you used. For ex-

ample, when I paint an orange brush stroke, there are dark and light oranges on the canvas be-

cause of the way the light shows up the stroke shapes. If I turn this setting OFF the sampler will 

pick up the orange colour I painted with. If I turn this setting ON then the sampler picks up the 

darker and lighter oranges.

The Felt Pen Tool. 

The Felt Pen Tool gives you a variety of felt tipped pens to use on your canvas. By changing its set-

tings you can create firm tips, soft tips, wet or dry tips, and any combination of those. Felt Pens can 

be used for precision work, particularly if they are wet tipped because they tend to sink in to the 

dents of the canvas more. They can also be used for rough highlighting when dry.

The Felt Pen Tool has the following properties: 

• Smudging: Pens don’t apply much ‘paint’ to your canvas, so they won’t leave lumps. This also 

means that they can’t smear, they will smudge when you run the Palette Knife over them.

• Blending: Wet pens will blend colors as you use them. The wetter the tip, the more the pigment 

will blend with other strokes.

• Build Up: Dry pens don’t blend very well, so as you use them over the top of other strokes they 

tend to make them darker.

When you select the Felt Pen, the following settings become available: 

• Pressure: The amount of pressure the Felt Pen applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the tool assumes. If you are using a tablet 

with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the pres-

sure, more the stroke sinks in to the canvas. Soft tipped felt pens will also change in size as you 

press harder.

• Softness: The softness of the pen nib is controlled using this slider. The softer the nib, the more 

expressive the stroke can become, because as you press harder it becomes larger. Hard tips will 

rarely change size as you press, soft tips will spread out as you press.

• Wetness: The wetness of the pen nib adjusts how color blends as you use it. Dry pens will tend to 

darken color they apply over. Wet pens will tend to blend with it and create solid blocks of color. 



Wet pens also create strokes that sink in to the canvas more. If you press lightly with a dry pen 

you’ll see a stroke broken up by your paper texture, if you press lightly with a wet pen the effect 

is much less visible.

• Art Pen: The Art Pen setting controls what style of pen you are using. Art Pens put down more 

ink so you get a more solid look to your pen strokes.

Having a soft tipped pen can allow for a lot of control over the shape of your stroke.

Having a wet tipped pen creates some smooth blending results if you use it on top of other strokes.

If you set your wet pen to draw with white as its color, you won’t see it apply anything (white’s 

transparent in a felt tip), but you will see it draw other colors out as it goes, almost like a water pen.



The Crayon Tool. 

The Crayon Tool gives you a stick of wax crayon to use on your canvas. Like the Chalk Tool, this 

tool can be used to bring out the texture of the paper but it also smears slightly due to the wax it ap-

plies. Soft crayons create a more lumpy look, while hard crayons create a softer result more like 

chalk. The Crayon’s a nice and simple tool for creating colored lines.

The Crayon Tool has the following properties: 

• Dryness: Crayon is a dry tool so it doesn’t smear, but it will smudge if you run the Palette Knife 

over it. However, because it’s waxy it does create a slightly smeared look while you are using it.

• Hardness: The tip of the Crayon is hard, so if you use it really lightly (if you have a pressure sen-

sitive tablet) you’ll see it doesn’t apply much, you press harder and it applies more. If you press 

lightly, you’ll only leave wax on the bumps in the canvas, not the dents.

When you select the Crayon Tool, the following settings become available: 

• Pressure: The amount of pressure the Crayon applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the tool assumes. If you are using a tablet 

with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the Pres-

sure, more crayon is applied, filling in the dents in the canvas.

• Softness: Controls the softness of the crayon. Softer crayons create a denser looking result be-

cause the wax flows more easily, while harder crayons create a softer result that fades more while 

you stroke.

If you want a bold stroke, use a soft crayon as the wax will build up faster.

The strokes in the image above have low Softness at the left, and high Softness at the right. Notice 

that the softer strokes look denser and the color is more visible.



The Eraser Tool. 

The Eraser Tool gives you an eraser that can be used to remove paint of all kinds from your canvas. 

Unlike a real eraser, this tool lets you remove oil paint as easily as you can remove pencil.

When you select the Eraser Tool, the following settings become available: 

• Pressure: The amount of pressure the Eraser applies. If you are using a mouse or tablet with no 

pressure sensitivity, this adjusts the level of pressure the tool assumes. If you are using a tablet 

with pressure sensitivity, it adjusts the amount of pressure the tablet applies. The higher the Pres-

sure, the more paint is erased from the canvas in your stroke.

• Softness: Hard erasers erase in solid lines with harsh edges. Soft erasers leave an amount of blur-

ring around the edge of their path, but also change in size as you press harder.

The Eraser Tool erases both the volume of paint from the canvas, and its color. As you start to erase, 

the eraser will remove the volume first.

In the image above, we ran an eraser once over a very lumpy patch of paint. Notice at the left that 

the color is still there, but the lump has been erased. If we continue to run the eraser back and forth, 

as we did in the right hand area, the color also vanishes.



The Tool Settings Panel. 

The Tool Settings Panel is stuck to the left hand side of the ArtRage window. Inside it you will find 

controls relating to the currently selected tool. The controls themselves are detailed in the sections 

on the specific tools, earlier in this manual.

If a tool has no settings, the panel will be hidden. If it does have settings, the panel will appear and 

provide dials for editing those settings. Each tool that has settings also has a Reset button that can 

be pressed to load the default settings for the tool.

By clicking and dragging the green grip on this panel, you can drag it up and down the window’s 

edge. If you just click it, the panel will retract. If you don’t plan on using the Tool Settings, just re-

tract it and leave it shut.



The Color Picker. 

The Color Picker, located at the bottom right hand side of the screen, is used for selecting colors 

and loading custom pickers.

There are four main parts to the picker: The big color wheel at the left hand side, the color slider 

next to it on the right, the color sample at the bottom right corner, and the control bar that sits un-

derneath the color wheel.

Some tools can get dirty as you use them. If you have one of those tools selected and you have not 

turned AutoClean on in the Tool Settings panel, you will also get a glass of water that can be used to 

clean the tool.

Selecting A Color. 

The big color wheel and the slider are used to select your current color. By default, the color wheel 

shows you the Hue and Saturation of your color (basically, the color and how vivid it is), and the 

slider shows you the Brightness. Click and drag inside the color wheel to select the Hue and Satura-

tion you want, then inside the Slider to select how bright it should be.

Regardless of the mode the color picker is in, you can click in those two controls to select your 

color.

As you select colors, the bottom right hand corner updates to show you the color you have selected. 

If you click that, a numeric color picker appears that lets you select color values directly. For more 

information on this, see ‘Numeric Color Picking’ later on in this section.



The Control Bar. 

In the control bar underneath the big color wheel you will find two controls: A slider for setting how 

metallic your paint will be, and a menu arrow.

The Menu Arrow opens up the color menu which contains a number of important options for color 

picking. From this menu, you can select the mode the big color wheel and color slider are in, and 

load or create custom color pickers. From this menu you can also open the Color Samples Panel 

(see later in this manual).

The different modes of the color picker are useful in different situations. Depending on which mode 

you select the big wheel and color slider will update to show different elements of the color you are 

selecting. ArtRage selects the H/S, L model by default. In this model the Hue and Saturation of your 

color are shown in the big wheel, and the Luminance is shown in the slider.

If you have a Tracing Image loaded, you can also select in this menu whether color is sampled from 

it automatically as you paint.

When you are in this mode, the color wheel updates to show you that color is being selected auto-

matically.

Metallic Paint. 

One of the features of the Color Picker is the ability to make your paint metallic. The difference be-

tween metallic and normal paint is quite significant.



The image above shows four strokes of yellow paint with the Metallic slider increasing in value 

with each stroke. Metallic strokes reflect some of the light ArtRage shines on the canvas, and you’ll 

see more detail in their textures because of this.

Thick metallic paint can be smeared around like normal paint, and gives the effect of molten metal 

on your canvas. Thin metallic paint looks like metal leafing, such as gold leaf applied to your paint-

ing.

If you smear metallic paint together with normal paint, the two blend and create some subtle grada-

tions of color and reflection.

Metallic paint is particularly useful with the Glitter Tool, and can also be good when applied with 

the Airbrush because it creates a thin metallic coating over the canvas. ArtRage lets you use it with 

any tool however, so if you want to try metallic crayons or pencils, feel free! Just remember that 

metallic paint changes the color of the paint being applied because it interacts with the lighting, so 

you won’t get solid color blocks when you’re using it.

Water Glass. 

If you are using a tool such as the Oil Brush that can get dirty, and the AutoClean option for that 

tool is not turned on in the Tool Settings Panel, you will see a glass of water sitting next to the Color 

Picker. Clicking this glass of water will clean your tool.

Tools that get dirty remember the color you last painted over, and will apply some of that color 

when you start painting again. If you do not clean them, you won’t get a pure color when you start 

painting. Every time you clean your brush in the glass of water, the color on the brush head changes 

to match the currently selected color. If you choose a new color before you paint again, your brush 

will update to match that.



Custom Color Pickers. 

Using the Color Menu in the control bar at the bottom of the Color Picker, you can load and create 

Custom Color Pickers. Custom Color Pickers are pictures you can sample color from for your paint-

ing. When you select a Custom Color Picker, it appears in the big wheel of the Color Picker.

In this mode, clicking inside the big wheel selects the color under the mouse. Using the color slider 

to the side adjusts the brightness of the color you chose so you can create shades of it.

Custom Color Pickers are handy when you want to create a painting using colors from something 

else. A portrait might require certain flesh tones, so loading a portrait as a custom picker would let 

you sample them directly from there. You can load any image you like in to the Custom Picker, just 

select the Load Custom Picker option from the Custom Picker menu inside the Color Menu.

ArtRage has some custom pickers stored with it by default, these can be accessed from the menus 

that are inside the custom picker menu. If you choose to create a custom picker, it will be created 

and placed inside the User folder of the ArtRage/Resources/Pickers folder.

When you select the Create Custom Picker menu item from the custom picker menu, the custom 

picker pane appears.

You can drag this pane around using the green grip. The area inside the big arc will be sampled to 

create your picker when you press the tick button. If you want to cancel, press the cross button or 

hit the escape key.

Using the Create Custom Picker option, you can blend paints on your canvas then store them for 

later use with any painting you have, as they can be selected from the custom picker menu’s User 

menu.



Numeric Color Picking. 

When you want to choose a color by entering its color values directly, you can use the Numeric 

Color Picker. To open it, either select the Numeric Color Picker entry from the Color Menu, or click 

the color sample at the bottom right of the color picker.

When it opens, your current color is displayed and you can edit its RGB or HLS values using the 

dials and text entry boxes in the panel. When you edit the color, the ‘New’ color sample updates 

with your new result. Click the ‘Original’ color sample to reset to the original color if you wish.

Pressing Cancel leaves the dialog without applying the changes. Pressing OK applies the changes 

and closes.



The Color Samples Panel. 

The Color Samples panel is used to store colors you want to use in your painting. Using this panel 

you can save and load sets of colors, and recall them for use whenever you need them in your work.

You can open the Color Samples panel by selecting ‘Show Color Samples Panel’ from the Color 

Picker’s menu, or from the Tools menu at the top of the window.

The Color Samples panel floats on the canvas and can be moved around to wherever you need it. To 

make it appear use the Color Samples button on the Color Picker.

The panel is empty when it first opens. To add a new color just click the ‘New’ button at the bottom.

The color appears in the panel. When you want to use it later, just click the color and it will be se-

lected.

If you want to remove the color from the panel, right click it and select the ‘Remove Sample’ op-

tion.

If you want to, you can give your color samples names. to do this, click the ‘Name’ button at the top 

of the panel. This changes the panel layout.

Each color sample can be named by right clicking it and choosing ‘Set Sample Name’. When you 

add a new sample in this mode, you can immediately enter its name.



The size of the panel can be adjusted vertically if you click and drag the grips on the bottom cor-

ners.

You can also load and save combinations of color samples using the menu, accessed from the arrow 

at the top of the panel. If you have old color sets from previous versions of ArtRage, you can assign 

names to them and re-save them for use later.

To close the panel, just click the X button at the top. To move it around, click and drag the green 

Grip. 



The Toolbox. 

The Toolbox Panel exists on the bottom edge of the ArtRage window. This panel contains tools for 

manipulating your canvas (such as moving or rotating it), and ‘boxes’ of items that you might want 

on the canvas.

To the left of the Toolbox are three tools used to manipulate the canvas. These are the Move tool, 

the Zoom Tool, and the Rotate Tool. To use these tools, click the button to activate them, then click 

and drag in the canvas as if you were using a normal paint tool. 

• Move Tool: When you click and drag in the canvas with this tool active, the canvas is dragged 

around inside the window. Use it to drag the part of your painting that you wish to work on to the 

centre area for each access.

• Zoom Tool: When you click and drag left and right in the canvas with this tool active, the canvas 

zooms in and out. If you wish to work in detail on a part of the canvas use this tool to zoom in to 

it.

• Rotate Tool: When you click and drag left and right in the canvas with this tool active, the canvas 

rotates. If you wish to put the canvas at an angle to make it easier to paint, use this tool.

If you have moved, zoomed, or rotated your canvas you can reset it to normal position by selecting 

the appropriate Reset option from the Tools menu in the Menu Bar at the top.

To the right of these tools are three ‘boxes’. Each one of these contains items you might want to use 

on your canvas.

• Stencils: The Stencils button brings up the Stencil Picker. This picker lets you add stencils to your 

canvas and manipulate them when they are there. Click it to show the picker, or hide it if it is al-

ready visible.

• Tracing: The Tracing button lets you work with Tracing Images. Click it if there is no Tracing 

Image loaded and you will be given the option to load one. If there is a Tracing Image already 

loaded, clicking this button gives you options for the Image and a way to clear it if you don’t want 

it any more.

• Refs: the Refs button lets you load reference images. Click it to load a new Reference Image that 

will be pinned to the canvas.



The Menu Bar. 

On Windows, the menu bar will look like the image below.

On the Mac OSX it looks somewhat different, like this. You'll find the file, edit, tools and help 

menus in the OSX menu bar.

The Menu Bar contains menus for editing various settings and actions in ArtRage, and a number of 

buttons for quick access to features.

The buttons along the left of the Menu Bar relate to various menus. Click them to open their menus. 

These menus are: 

• File: Contains items related to loading, saving, and printing your paintings.

• Edit: Contains items related to editing the work you are doing, and preferences for the applica-

tion.

• Tools: Contains items related to the painting tools, the canvas, and your layers.

• Help: Contains items that let you get help on the application, or look for updates.

The buttons on the right of the Menu Bar are used as follows, in order left to right:

• Zoom: The Zoom control allows you to zoom in or out using the +/- buttons, or enter a zoom 

value automatically.

• Undo/Redo: Undo is the arrow pointing left, Redo points right. You may undo any number of 

paint strokes you have made using the Undo tool. Note that many other things such as adding or 

deleting a layer can also be undone. If you wish, you can redo operations you have undone.

• Hide: The flat bar button hides ArtRage.

• Size: The window button changes the size of the ArtRage window between a normal sized, or a 

full screen window.

• Close: Closes the application. If you have unsaved changes in your painting you will be prompted 

to save first.



The File Menu. 

The File Menu contains items relating to your painting. They work as follows: 

• New Painting: Opens the New Painting dialog that allows you to create a new painting.

• Open Painting: Opens a file dialog that allows you to load a painting from disk.

• Save Painting: Saves your current painting. If you have not saved it before, you are prompted to 

enter a name.

• Save Painting As: Saves a copy of your current painting as a new one, prompting you for a name.

• Export As Image: Exports your current painting to an image file other applications can read. Be-

cause ArtRage contains a lot of information most image viewers don’t use, you will need to ex-

port your painting if you wish to show it to someone using another package, or on the web.

• Import Image: Loads an image from disk as a painting file. When you use this, the image is 

loaded in and ‘converted’ to oil paint so that it can be smeared around.

• Import Image to Layer: Loads an image from disk and drops it in to a new Layer in the current 

painting. When you use this, the image is converted to oil paint so that it can be smeared around.

• Recent Files: This menu contains a list of recently loaded files. Select an item in the list and that 

file will be loaded.

• Print Painting: Prints your painting.

• Quit: Closes the application, prompting you to save changes if there have been any since the last 

save.

For more information on loading, saving, and printing your paintings, see the ‘Creating, Saving, and 

Printing Paintings’ section earlier on in the manual.

The Edit Menu. 

The Edit menu contains items related to the work you are doing. They work as follows:

• Undo: Undoes the last painting operation you performed. Strokes of paint can be undone, as can 

layer changes or resizes. Anything that edits your painting will be able to be undone.

• Redo: Redoes the last operation you undid.

• Rescale the Painting: Opens up the Rescale panel, allowing you to change the size of your paint-

ing.

• Resize the Canvas: Opens up the Resize panel, allowing you to change the size of the paper 

you’re painting on.

• Copy Layer to Clipboard: Copies the contents of the current layer to the clipboard so that it can 

be pasted in to another application.

• Paste Clipboard to New Layer: Pastes the contents of the clipboard to a new Layer. The con-

tents of the clipboard must be an image if this is to work. Depending on the nature of the contents, 

they may be pasted with their transparency intact.

• Transform Layer Contents: Opens up a panel that allows you to move, scale, and rotate the con-

tents of your current Layer or Layer Group.

• Transform All Layers: Opens up a panel that allows you to move, scale, and rotate the contents 

of all Layers at once.

• Preferences: A sub-menu containing preferences items.



The Preferences Menu.

The Preferences menu contains the following items: 

• Auto Check Weekly For Updates: If ticked, ArtRage will automatically check online each week 

to see if there are updates to download.

• Play Sounds: In the Preferences menu. Toggles whether or not ArtRage will play sounds when 

events happen such as cleaning your brush or opening a panel. 

• Play Panel Transitions: In the Preferences menu. Some panels will animate as they appear and 

disappear, this allows you to turn that off.

• Use Precise Cursor: In the Preferences menu. If this is turned on, ArtRage will use a crosshair 

cursor for all tools. If it is turned off, ArtRage uses tool size cursors.

• Magnify Precise Cursor: If this is turned on and Use Precise Cursor is turned on, the crosshair 

cursor will be larger and more visible.

• Hide Task Bar in Full Screen Mode: (Windows Only) If this is turned on, ArtRage will hide 

your task bar when it is in full screen mode, taking over the entire screen. If it is turned off, the 

Task Bar will remain visible. 

• Precise Tablet Mode: (Windows only) ArtRage uses simple tablet coordinates by default, but 

some tablets support a higher resolution input system that will be used if this option is turned on. 

If you turn the option on and experience problems with the paint strokes, your tablet does not 

support the correct coordinates.

For more information on Rescaling the painting and Resizing the canvas, see the section ‘Resizing 

& Rescaling Your Work’ later on.

The Tools Menu. 

The Tools Menu contains items related to your tools, canvas, and layers. They work as follows:

• Select Tool: Opens a sub menu that allows you to select which tool is active.

• Reset Current Tool: Resets the settings of your current tool to default.

• Layer Options: Opens the Layer Options menu (see below).

• Stencil Options: Opens the Stencil Options menu (see below).

• Tracing Options: Opens the Tracing Options menu (see below).

• Colour Options: Opens the Colour Options menu (see below).

• Open a Reference Image: Allows you to open a new image as a painting reference.

• Remove All References Images: Clears away all images you have loaded as painting references.

• Reset Canvas Rotation: Resets the canvas so that it is at its default rotation angle.

• Reset Canvas Scale: Resets the canvas to 100% scale.

• Reset Canvas Position: Resets the canvas to be centered on the screen.

• Show Color Samples Panel: Shows or hides the Color Samples panel.



The Layer Options Menu.

The Layer Options menu contains the following items, see the section on Layers later in this manual 

for more information:

• Add a New Layer: Adds a new layer to your painting.

• Delete Layer: Deletes the current layer you are working on.

• Clear Layer: Wipes away the contents of the current layer you are working on.

• Duplicate Layer: Creates a copy of your current layer and adds it to the painting.

• Export Layer: Saves the layer you are working on out as an image file.

• Transform Layer Contents: Opens the Layer Transformation Panel and allows you to move, 

scale, and rotate the contents of the currently selected Layer.

• Make a Stencil From This Layer: Creates a new Stencil from the contents of the current Layer. 

For more information on Stencils, see the Stencils section later in this manual.

• Merge With the Layer Below: If there is a layer beneath the one you are currently working, se-

lecting this causes the current layer to merge down and become part of the one below.

• Merge All Layers: Merges all of the layers in the painting in to one.

• Layer Blending:Allows you to select the blending mode used by the current layer. For more in-

formation, see the section on Layers. This menu item will not be available when you have the bot-

tom layer active.

• Close Layer Group: If the currently selected Layer is inside a group, selecting this option closes 

the group.

• Edit Paper Settings: Opens the Paper Settings Panel that allows you to adjust the properties of 

the paper you’re painting on, such as its color or roughness.

The Stencil Options Menu.

The Stencil Options Menu contains the following items, see the section on Stencils later in this 

manual for more information:

• Load A Stencil From Disk: Allows you to load in a Stencil from an image file on disk.

• Hide All Stencils: Hides any Stencils you have on the canvas.

• Show All Stencils: Shows any Stencils you have on the canvas.

• Remove All Stencils: Removes any stencils you have on the canvas.

The Tracing Options Menu.

The Tracing Options Menu contains the following items, see the section on Tracing Images later in 

this manual for more information:

• Load New Tracing Image: Loads in an image for tracing.

• Clear Tracing Image: Removes any image currently loaded for tracing.

• Show Tracing Image: If there is an image loaded for tracing, this option toggles whether or not it 

is visible.

• Choose Colors From Tracing Image: If ticked, ArtRage will automatically select colors from 

the Tracing Image as you paint.

• Convert Tracing Image to Paint on this Layer: Takes the contents of the current Tracing Image 

if you have one and converts it to paint on the current Layer.



• Edit Tracing Image: If you have a Tracing Image loaded, this opens the Tracing Image Settings 

Panel that allows you to edit the properties of your Tracing Image.

The Color Options Menu.

The Color Options Menu contains the following items, see the section on the Color Picker earlier in 

this manual for more information:

• HL / S Picker, HS / L Picker, LS / H Picker: Sets the Color Picker to display color in one of the 

Hue, Luminance, and Saturation picker types.

• RG / B Picker, RB / G Picker, BG / R Picker: Sets the Color Picker to display color in one of 

the Red, Green, and Blue picker types.

• Numeric Color Picker: Opens up the Numeric Color Picker for color selection by number.

• Choose Colors From Tracing Image: If ticked, ArtRage will automatically select colors from 

the Tracing Image as you paint.

• Load Custom Picker: Allows you to load a Custom Color Picker from an image on disk.

• Create Custom Picker: Allows you to create a new Custom Color Picker by sampling the paint 

on your canvas.

The Help Menu. 

The help menu contains three simple items relating to the application: 

• ArtRage Manual: Opens this manual.

• Online Product Support: Opens up the online ArtRage support page.

• Shortcut Keys: Opens up the manual’s shortcut keys list.

• Check For Updates Online: Checks to see if there are newer versions of the application avail-

able online.

• About ArtRage: Opens the ArtRage about box which gives information on your current version.



Resizing & Rescaling Your Work. 

ArtRage lets you change the size of your painting, and the size of the canvas you’re painting on. 

These two processes are very similar in how they work, but do two very different things. Both op-

tions are available from the Edit Menu.

In short, rescaling changes the size of everything, including the paint on your canvas, while resizing 

changes just the size of your canvas and not its contents, giving you a larger or smaller area in 

which to paint.

Rescaling Your Painting. 

The Rescale option changes the size of your canvas and everything in it. You can use it if you want 

your painting to be larger or smaller than you have been painting it. When you use this option, the 

contents of your painting change size. Selecting the Rescale Your Painting item from the Edit Menu 

opens the Rescale panel.

This panel allows you to set a new size for your painting, using either the pixel size or a percentage 

of the current size. You can also rescale it to fit the screen size, or the size of a Tracing Image if you 

have one loaded.

When you have selected the new size, click OK to apply it or Cancel to cancel the change. Note that 

if you choose to apply, it may take some time if you have many layers, there’s a lot of information 

that needs to be changed!

By clicking the ‘pixels’ button you can change the units ArtRage uses to calculate the size of your 

painting. You can select from pixels, inches, centimeters, and millimeters.

By changing the dpi value, you can adjust the print resolution of your painting if you wish to meas-

ure it for printing.

The Preset Sizes button opens a menu that contains predefined sizes you can use, and allows you to 

reset your painting’s size if you are not sure of the current settings. Using this menu you can also 

store your current settings as a preset for access later.



Resizing Your Canvas. 

The Resize option changes the size of your canvas without changing the size of any of the paint in-

side it. This means that if you find you do not have enough space for a painting you started, you can 

simply increase the size of the canvas to get more space. Similarly, if you find that the size of your 

canvas is too large for a painting you have done, you can shrink it down without changing the paint 

inside. Selecting the Rescale Your Canvas option from the Edit Menu opens the Resize Panel.

This panel allows you to set a new size for your canvas, using either the pixel size or a percentage 

of the current size. You can also resize it to fit the screen or a Tracing Image if you have one loaded.

When you change the size of the canvas, your current paint will need to be positioned inside the 

new canvas area. To do this, use the painting preview at the bottom of the dialog. The preview size 

indicates the new canvas size, and inside it you can drag around the current painting area to indicate 

where it should be positioned. The position menu allows you to choose some preset positions for 

the paint inside the new canvas.

Note: If you make your canvas smaller than it used to be, you may lose some paint, make sure the 

preview looks correct and that you have not lost any important bits off the edge before you press 

OK.

You can press OK to apply the changes, or Cancel to discard them. Note that if you choose to apply, 

it may take some time if you have many layers!

The ‘pixels’ button, dpi settings, and Preset Sizes controls work in the same way they do in the Res-

cale Panel above.



All About Layers. 

Layers are an important part of ArtRage, and understanding them can be tricky. This section ex-

plains what they are and how to use them. If you don’t understand, or don’t want to use them, that’s 

no problem as ArtRage works fine without you ever needing to touch them, but they are a powerful 

tool for creating more complex images.

What Are Layers? 

Layers are basically sheets of transparent paper that can be stacked on top of each other and painted 

on. As many of these sheets can be stacked on top of each other as you like and you can paint on to 

any of them at any time.

This means you can build up a painting by putting different parts of it on different sheets. For ex-

ample, a painting of an apple might start out with the table and background on their own layer, then 

on to a new sheet above you paint the apple itself. The apple covers the table, but you could at any 

time erase it and still see the table behind because it’s on its own sheet.

Layers do not need to be transparent. When you open up ArtRage there’s a sheet of canvas there 

ready for you to use, and that sheet is actually a Layer. That Layer has been told that it is made out 

of a sheet of paper rather than a transparent cell, so you can’t see anything behind it. If I added a 

new Layer that had also been told to be a piece of paper, everything underneath would be hidden, it 

would be like turning the page in a sketch book and hiding the page underneath.

Layers can be used to simulate the drying of paint. Take the apple example again. If you paint the 

table on a canvas, you would generally wait for the paint to dry before painting the apple over it. In 

our case, we paint the table on a Layer then add a new transparent Layer so that we can paint the 

apple. The table paint beneath is still there but it’s not mixing with the apple paint, so it’s like we’ve 

left the table to dry. Of course, if we want we can still go back and paint on the table layer and it 

will be like it was before, wet, but it still won’t blend with the apple.

When there’s a transparent area of a layer, we illustrate this by putting checkers in the hole. You can 

see this in the apple layer above. If we make the table layer transparent we’d see checkers in our 



painting, not just the mini-preview. But don’t worry, those checkers won’t be there if you print your 

painting or Export it. They also won’t blend with your colors as you paint.

Layer Groups.

Sometimes, in a complex document that has many layers, you might want to group them together to 

make it easy to locate them, to edit them, or to show or hide them while you are working on other 

things. In our apple example above, we might want to hide the Apple so that we can see the table 

layer beneath and paint in the contents of the white hole. But what if the apple was painted on to its 

own set of layers, rather than just one?

In this example the apple and table layers have been grouped together differently. The apple is actu-

ally made up of multiple layers of paint on top of each other, which we can see when we open up 

the Layer Group it’s in.

When the Apple group is opened, we can see that the apple is made up of three different layers. The 

stalk is at the top, the main body of the apple is in the middle, and its shadow is below. The advan-

tage to placing these items in a group is that you can collapse it down so that you don’t need to see 

them when you’re working on other things. Better yet, if I want to make the apple smaller I can just 

make the Apple group smaller and everything inside it scales as well.



Using Layers. 

Using Layers in ArtRage is easy. The Layer Panel is stored on the right hand edge of the screen, and 

you can click its green grip handle to retract it or reveal it. When you want to add a new Layer you 

can do so by clicking the Add Layer button at the bottom of the Layer panel. If you prefer, you can 

select Add a New Layer from the Layer Options menu in the Tools Menu.

When a new Layer is added, it is transparent by default so you won’t actually see any change on 

your canvas. However, the Layers Panel will update to indicate that you have a new Layer. Because 

the Layer is transparent, the preview will display checkers.

You can paint on to your layer whenever you like. When you do so you will notice a few things: 

• Your paint doesn’t mix with any paint from the layers underneath.

• If the layers underneath have any lumpiness, it will show through on your new layer as if you 

were painting over them.

• The paint you apply will appear in the mini-preview of your layer in the Layer Panel as per nor-

mal.

There are many more things you can do with layers, those are generally accessed via the Layer 

Panel, for more information, see later in this manual.

Layer Blending. 

Layer Blending allows you to tell the paint on your Layers to interact with the paint beneath in un-

usual ways. ArtRage supports the blending modes available in Photoshop, and if you Import or Ex-

port PSD files you will find their blend modes remain intact.

To access Layer Blending in ArtRage, use the Layer Blending menu which can be found inside the 

Layer menu for each Layer in the Layers Panel (the arrow by each preview) or in the Menu Bar un-

der Tools / Layer Options. This menu will not be available for the bottom Layer of your painting, 

because there is nothing beneath that Layer to blend with.



The default setting for Layer Blending is 'Normal'. Normal mode means the paint in the Layers just 

sits on top of everything beneath as you would expect.

The three modes underneath that are Tint, Shadow and Highlight. Setting a Layer to Tint means that 

any color on that Layer is used to tint the color of the Layers beneath. This can be very useful if you 

want to add color to a black and white image. Setting a Layer to Shadow means that the color you 

apply will blend with the color on the Layer beneath to create a darker result. This can be useful 

when you want to apply subtle shadowing to objects in a painting. Setting a Layer to Highlight does 

the opposite, highlighting the color of the Layer beneath.

Note that changing your Layer Blending mode does not damage the color you painted on the Layer. 

If you change the mode back to Normal, the color you painted will be returned to its original state. 

The results of these modes can be seen here:

!

The four different samples illustrated were painted on a layer over a grey line. Above each sample is 

a spot of the color used to paint. The leftmost sample shows Normal blending, where the paint just 

applies over the grey stroke. The next sample shows Tint blending, where the light blue tints the 

grey of the stroke. Where the light blue passes over transparency, it tints the checkers to show that it 

will tint any color you paint under it. The third sample shows Shadow blending, where the darker 

grey gets even darker where it passes over the grey stroke underneath, because the two blend to-

gether to create a darker result. The final sample shows Highlight blending, where the mid-range 

green is creating bright tinted highlights as it passes over the area beneath, blending to create lighter 

colors.

The More Blend Modes menu contains a long list of other blend modes supported in ArtRage based 

on those found in Photoshop. These blend modes are not as commonly used as the four basic ones, 

and produce a variety of different effects. Feel free to explore and try them out.



Under the More Blend Modes menu is a Bump Blend Modes menu, see below for more information 

on that.

If you have applied a Layer Blending mode to a Layer, you will see an indicator in the Layer Panel 

indicating the mode:

!

The small circle to the bottom right of the Layer preview tells you that a blending mode has been 

applied. The + indicates a Highlight mode. The - indicates a Shadow mode. The T indicates a Tint 

mode. Normal mode has no indicator, and every other mode from the More Blend Modes list uses 

'...'. If you click the indicator, the Layer Blending menu pops up so you can set the mode easily.

Bump Blend Modes.

The term ‘Bump’ refers to the lumpiness of your paint on the canvas. Normally, when you paint on 

a layer, the lumpiness of any paint on layers beneath shows through, giving you a feeling of texture 

from the paint below. There may be times however where you want the lumpiness of the paint to 

work differently.

The Maximum mode is the normal mode ArtRage uses. The following image illustrates the differ-

ence between the three modes.



These four strokes were made on different layers, and the Bump Blend Mode of the light blue 

stroke layers was changed.

The leftmost stroke uses Maximum mode. The highest peak of the two strokes of paint shows 

through, so the two blend together.

The middle stroke uses Replace mode. The topmost layer replaces the lumpiness of the lowest layer, 

the paint cuts through anything beneath it.

The rightmost stroke uses Add mode. The two layers add together to make a higher peak.

Bump Blend Modes can be tricky to understand, particularly when you have lots of layers in a 

document and their blend modes are different. If you ever need to get back to normal, just select the 

Maximum Mode and your painting will behave like a normal ArtRage painting.



The Layers Panel. 

The Layers Panel contains all of the Layers in your painting, and lets you edit their properties. It 

sticks to the right hand edge of the ArtRage Window.

At the top left of the panel is a green grip that can be used to drag it up and down, or clicked to re-

tract the panel in to the side of the window. The menu button opens a menu that contains items for 

manipulating layers:

• Find Selected Layer: If your selected layer is not visible, just select this option and the Layer 

Panel will find it for you.

• Add A New Group: Adds a new group to your layer panel, you can then drag layers in to it for 

storage.

• Add Layer: Adds a new Layer to your painting.

• Merge All Layers: Merges all layers down in to a single layer, keeping the look of the painting 

intact.

The order in which the Layer Previews appear indicates how they are stacked in the canvas. The 

bottom-most Layer in the Panel is the background, and each item on top of it is placed in that order 

one on top of the other, so the topmost item in the Panel is the topmost visible sheet in your canvas.



The Layer Thumbnail. 

For every Layer you have, the panel shows a single preview with 2 buttons attached. If the Layer is 

the currently selected one, the preview will sit on a green background. Otherwise, the background 

will be grey. To select a layer, click on its thumbnail.

The top button to the left sets whether the Layer is visible. If a Layer is hidden, it is not displayed in 

the Canvas but still exists and can be brought back later. If you want to paint on a layer beneath the 

top one you may find this useful, hiding paint that would get in the way of your work.

The bottom button to the left opens a menu containing options for the current layer.

The Name item allows you to set the name of the Layer. If a Layer has a name, it will be displayed 

underneath the thumbnail in the Layer Panel. If the Layer’s name is No Name (the default value), 

no name is displayed. You can use Layer Names to keep track of what’s on layers that don’t have an 

obvious thumbnail image.

The Opacity item lets you set how opaque the layer is. Click and drag to change the value. The 

lower the value, the more you can see through the paint to the layers below. If you click the slider 

instead of dragging, a text entry appears for you to change the value numerically.



The third item is the Blend Menu button and shows you what Blend Mode is currently selected for 

the layer. Click it to open the Blend Menu.

Beneath those items are a number of options for the Layer. These options are: 

• Delete Layer: Deletes the layer. Note that if you only have one layer you cannot delete it, Ar-

tRage must have 1 layer at least.

• Clear Layer: Wipes away the contents of the layer indicated.

• Duplicate Layer: Creates a copy of the layer who’s menu you selected this from and adds it to 

the painting directly above it.

• Export Layer: Saves the layer out as an image file.

• Transform Layer Contents: Opens up the Layer Transform Panel, which allows you to move, 

scale, and rotate the contents of the Layer.

• Make A Stencil From This Layer: Creates a Stencil using the contents of the layer. See the sec-

tion on Stencils for more information.

• Merge With the Layer Below: If there is a layer beneath the one you selected this option for, se-

lecting this causes that layer to merge down and become part of the one below.

• Merge All Layers: Merges all of the layers in the painting in to one.

• Close Layer Group: If the layer is in a group, this option will close the group. This can be handy 

if the top of the group is not visible in the Layer Panel.

• Edit Paper Settings: Opens the Paper Settings Panel that allows you to adjust the properties of 

the paper for the layer who’s menu you selected this from.

Using Layer Groups.

Layer Groups can be used to gather similar layers together and manipulate them as one object. To 

add a Layer Group to the Layer Panel, select Add A New Group from the menu at the top of the 

Layer Panel.

A closed Layer Group is contained within two cutout lines. Under the top line is a Menu Arrow, 

which can be clicked to bring up the Layer Group Menu, a name for the group, and a folder icon 

that indicates whether the group is open or closed.

Underneath that, above the bottom line is a grip that can be clicked to open or close the Group. You 

can click the Group’s name to open or close it too.

When a Group is closed, it can be dragged around like any other Layer. Just click and drag the top 

half of the Group’s indicator (where the name is) and you can drag the group up and down in the 

Layer Panel. The arrow tells you where it will be dropped. When you move a Group in this manner, 



all of the layers inside it move as one, so in the case above, if we dragged our Apple group below 

the background, all the elements that make up the apple would move and be obscured.

When you click the Menu Arrow on the group’s titlebar, the Layer Group Menu appears.

The Name item allows you to set the name of the group. 

The Opacity item lets you set how opaque the group is. Click and drag to change the value. The 

lower the value, the more you can see through the paint to the layers below. If you click the slider 

instead of dragging, a text entry appears for you to change the value numerically. The opacity of a 

group is applied to all layers inside that group, no matter how opaque they are, but the opacity value 

indicated by those layers does not change.

The third item is the Blend Menu button and shows you what Blend Mode is currently selected for 

the group. Click it to open the Blend Menu. Groups have a special Blend Mode: ‘None’. When the 

blend mode is None, the group applies no special blending to its contents. You can set blend modes 

for groups and they apply to the layers inside them, but the results can be confusing if you’re not 

used to how groups work.

If you use Adobe Photoshop, the ‘None’ blend mode is the equivalent of the ‘Pass Through’ blend 

mode used for groups in that application.

The options beneath the three top items work as follows:

• Add A Layer To Group: Adds a new layer to the top of the group.

• Duplicate Group: Creates a duplicate of the layer group and all its contents.

• Delete Group: Deletes the group and all its contents.

• Merge Group Contents: Merges all of the contents of the group, and the group itself in to a sin-

gle layer.

• Transform Group Contents: Opens the Layer Transform Panel, allowing all the contents of the 

group to be moved, scaled, and rotated as if they were one layer.



Adding Layers To Groups.

To add a layer in to a closed group, just drag the layer until the arrow that indicates where the layer 

will be dropped points between the start and end of the group you wish to drag it in to.

If a group is open, just drag the layer you wish to add to it up until the arrow appears either above or 

below one of the layers already inside the layer group.

If your currently selected layer is inside a group and you select Add Layer, the new layer will ap-

pear above the selected layer, inside the same group. If the group containing your selected layer is 

closed when you add a new layer, the group will open so that you can see the selected layer’s posi-

tion.

You can add groups to other groups just by dragging them as you would any layer.

Moving Layers. 

You can move layers up and down in the stack on your painting. Layers go behind all paint that is 

on Layers above them in the panel. For example, in this image, the blue circle is in front of the red 

square.

If I want to move the red square so that it is on top of the blue circle, I click and drag the red square 

Layer preview in the Layer panel. I drag it up and drop it when the arrow that appears indicates it 

will be put on top of the circle. Of course, when I put it on top, it hides the blue circle because the 

red square’s Layer has been told that it’s made of paper.

So we currently can’t see the blue circle at all, even though we can see it’s there in the Layer Panel. 

I can change that by telling the Red Square Layer to be made of transparent paper, and the Blue 

Circle Layer to be made of normal paper. To do this I use the Paper Settings panel, which can be 



accessed from the layer thumbnail’s menu button. For more information, see the section on the Pa-

per Settings panel in this manual.

You can see from the previews in the Layer Panel that the blue circle layer now has a solid canvas 

background, while the red square is transparent and sits on top.



Moving, Scaling, and Rotating Layers.

ArtRage lets you move, scale, and rotate the contents of your Layers on the canvas. This can be use-

ful for positioning items that were painted in the wrong place, or adjusting items that have been 

brought in from another painting or application to fit the surrounding detail.

To do this, you need to select ‘Transform Layer Contents...’ or ‘Transform All Layers...’ from the 

Edit Menu. When you select this, the interface disappears and you are taken in to Layer Move 

mode. In this mode, you have a set of tools specifically for moving, scaling, and rotating the Layer 

you chose, or all Layers.

When you import an image to a new Layer (using the option in the File Menu), you are automati-

cally taken in to Layer Transformation mode.

The Layer Move controls look like this: 

The left three buttons set the type of move you want to make: Move, Scale, or Rotate. Select a but-

ton and click and drag on the canvas to adjust the Layer.

While you are in this mode, Undo and Redo will undo and redo only the moves you have made, so 

you can try things out without committing to them.

When you are done, press Cancel to return to the normal interface without making the move, or OK 

to accept the move and return.

The arrow button on the right hand side opens up a Menu that allows you to flip the contents of the 

layer and zoom in to our out of the canvas to see more of your painting.

You can move the toolbar around using the grip on its left hand side.

Note: Moving the contents of Layers around can be slow, so to keep things moving quickly we 

change their appearance while you are moving them. While you’re dragging, the Layer’s paint will 

lose its ‘volume’ and appear flat. Don’t worry, it won’t look like this when you are done!



Paper Settings Panel. 

Each Layer is made of a material, Paper for example. The Paper Settings panel is used to edit what 

material is being used.

The Paper Settings Panel can be opened from the from a menu attached to one of the layers in the 

Layer Panel. You can also find it in the Tools Menu under Layer Options.

When you open the panel it displays the settings of the paper you are currently using. The Panel is 

split in to a number of sections. At the top is the Presets section which shows you a variety of pre-

sets available for use. At the bottom of that section is a preview of your current settings. Beneath 

that is the control section that present you with controls for adjusting you paper. Finally, an OK and 

Cancel button allow you to apply or discard your changes.

Paper Presets. 



Rather than setting up your paper yourself, you can use one of the presets we provide. To select a 

preset, just click it and its settings will be used. Then press OK to apply those changes.

Right clicking a preset gives you the option to delete it if you wish, this will remove it from disk so 

it won’t appear next time you open the panel.

Beneath the presets are two buttons: Previous and Next. Those allow you to browse the presets if 

you have more than one page worth. Click them to scroll to the next or previous page.

Underneath that is a long preview that shows you what your current settings will look like, with a 

chalk stroke over it to show how paint will interact.

Beneath that is a button that allows you to make a new preset. Click it and enter the name of the 

preset and your current settings will be saved as a new preset that can be used later.

Paper Controls. 

The Paper Controls section contains dials and controls used to adjust paper settings. These work as 

follows: 

• Grain: Click the grain sample and a picker will appear that allows you to select one of the three 

basic grain types ArtRage provides, or load another from disk. Your ArtRage/Resources/Grains 

folder contains custom grains we have provided. Grain images use the brightness of the image to 

represent dents and bumps, their color is ignored and will not appear on the canvas.

• Roughness: Adjusts how rough the grain is. The higher the value, the rougher your paper be-

comes. The + button next to the Roughness Dial can be used to invert the grain, so that every 

lump becomes a dent and vice versa. Clicking the + button changes it to a -, clicking it again re-

turns it to a +.

• Scale: Adjusts the scale of the grain. Set to 50% at the grain will be at normal scale, move the 

value down to shrink it, or up to expand it.

• Opacity: Adjusts how opaque your paper is. Real paper would be set to 100%, tracing paper 

around 50%, and transparent cell 0%. Remember that if your paper is not transparent it will cover 

over any Layers beneath it in your painting.

• Metal: Adjusts how metallic your paper is. Normal paper would be set to 0%, tin foil to 100%. 

Metallic paper can be quite striking, but also quite distracting. Fortunately, you can adjust this 

value at any time if you find it is too high after you have been painting.

• Color: Click the color sample to select a new color for your paper. This uses a Floating Color 

Picker, see the section on Floating Color Pickers near the start of this manual for more informa-

tion.



Tracing Images. 

ArtRage lets you load in a Tracing Image that is overlaid on top of your canvas for painting refer-

ence. If you are just learning to paint this can be a good way to create interesting images.

When you have a Tracing Image loaded, you can choose to have ArtRage select the color you are 

using based on the image. This means you don’t even need to worry about which color to pick, you 

can just paint strokes to match what you see beneath.

To load a Tracing Image, click the Tracing button on the Toolbox Panel which sits on the bottom 

edge of the ArtRage Window. You can also find this option in the Tools Menu.

When you have an image loaded, the Color Picker will update to indicate that color is being se-

lected from it, and the following options become available when you click the Tracing button on the 

Toolbox Panel (and also in the Tools Menu): 

• Load New Tracing Image: Loads a new tracing image and replaces the current one.

• Clear Tracing Image: Removes any image currently loaded for tracing. 

• Show Tracing Image: This option toggles whether or not it is visible.

• Choose Colors from Tracing Image: Tells ArtRage whether the colors it uses should be taken 

from a loaded Tracing Image. If this is turned on and an image is loaded for tracing, the Color 

Picker will inform you that color is being chosen automatically. Turn it off if you want to choose 

colors yourself.

• Convert Tracing Image to Paint on this Layer: Takes the Tracing Image you have loaded, if 

you have one, and converts it to paint, filling the currently selected layer. Good for turning a trac-

ing image in to paint so that you can then smear it.

• Edit Tracing Image: Opens the Tracing Image Settings Pane.

The Tracing Image Settings Pane. 

When you select Edit Tracing Image from a menu you are presented with the Tracing Image Set-

tings Pane.

This pane allows you to change the scale and position of the Tracing Image, along with how trans-

parent it is as it is displayed.

The Scale button opens a menu that allows you to select one of 5 types of scale: 

• Manual Scale: The image is not automatically scaled. With this option selected you can use the 

Move and Zoom tools on the panel.



• Tile Image to Fill: The image is tiled repeatedly to fill the canvas. With this option selected you 

can use the Move and Zoom tools on the panel.

• Stretch Image to Fill: Stretches the image so that it fills the canvas completely.

• Fit Image Inside: Stretches the image so that its largest edge fits inside the canvas. This doesn’t 

change the aspect of the image.

• Let Image Overlap: Stretches the image so that its smallest edge fits inside the canvas. Note that 

this means some parts of the image will be outside the area of the canvas.

If you have selected Manual or Tiled scale modes, you can use the Move and Zoom tools at the side 

of the preview. Select the tool you wish to use then click and drag in the canvas area to move or 

zoom the Tracing Image.

To adjust how opaque the Tracing Image is when displayed on your painting, adjust the Opacity dial 

to the right of the pane.

Click Done when you have finished making adjustments and the interface returns to normal.



Reference Images. 

ArtRage lets you load in an image to use as a painting reference. Unlike Tracing Images, Refer-

ences are ‘pinned’ to your canvas so that you can glance at them for reference rather than tracing 

directly. Reference Images are great when you’re trying to recreate something but don’t want to 

trace. You can have as many as you like and sit them wherever you want to glance at.

To load a Reference Image, click the Refs button on the Toolbox Panel which sits at the bottom of 

the ArtRage window, or select ‘Open a Reference Image’ from the Tools Menu. A file picker ap-

pears and allows you to select an image. When the image opens, it appears on your canvas with a 

pin.

To move the Reference Image, click and drag inside the pin head, or in the centre of the image it-

self. To scale the Reference Image, click and drag in one of the corners of the image. To rotate the 

Reference Image, click and drag in one of the edges of the image. The cursor will update as your 

mouse pointer passes over the Reference Image to indicate what would happen if you clicked and 

dragged there.

Right clicking a reference image or its pin head brings up the Reference Menu: 

• Set to Normal Size and Rotation: Returns the reference image to its default size and straightens 

it out.

• Make this a Tracing Image: Turns the reference image in to your current Tracing Image.

• Remove this Reference: Removes the reference from your canvas.

Tip: Want to sample color from your reference? With the Sampler Tool selected you can click in-

side the reference and that color will be selected. Alternatively, hold down Alt and click inside the 

image to sample from it!



Navigating Inside References. 

When you point the mouse pointer at a reference image, two buttons fade in to view. These are the 

Reference Zoom and Move tools. If you click and drag left and right on the Magnifying Glass but-

ton, the contents of the Reference Image will zoom (the Reference will stay the same size on your 

canvas). If you click and drag around in the Move button, the contents of the Reference Image will 

move around inside their frame. This will only work if you have Zoomed so that not all of the con-

tents are visible. Using these tools, you can zoom in to important parts of your Reference image 

without needing to change its size.



All About Stencils and Rulers.

Stencils and Rulers are used to create precise shapes or lines on your canvas. They work just as if 

you’d placed a piece of wood or plastic down on your canvas, letting you paint over them without 

the paint applying to the canvas beneath, or draw around them to make outlines.

Types of Stencil.

Stencil object in ArtRage can be in three modes. These modes behave differently and represent the 

different ways you might want to paint with real tools. The three modes are Stencil, Ruler, and 

Guide. Any Stencil object you add to your canvas can be set to any of those modes as you work, 

and changed as you wish.

Stencil Mode.

When set to this mode, the item works like a simple Stencil, stopping paint from being applied to 

the canvas beneath in. You can paint over it freely, and start your paint strokes on top of it.

Items in Stencil Mode are tinted red.

If you paint a stroke over the top of the Stencil then remove it, you will see a cutout in the stroke in 

the shape of the red parts of the Stencil.



If you lay items in Stencil mode on top of each other and paint over them, they work together, so 

you can create complex shapes using multiple Stencils.

Ruler Mode. 

When set to this mode, the item works like a Ruler, allowing you to ‘bump’ your tool against it and 

draw around its edge easily. Rulers are placed flat on the canvas so as you draw around them, your 

paint does not go underneath.

Items in Ruler Mode are tinted grey.

When you make a stroke and it gets close to the edge of an item in Ruler mode, it will stick to the 

edge. When the stroke is stuck to the edge like this, you can run the cursor roughly along the edge 

and the stroke will keep sticking. Think of it as if you’ve bumped your pen against the side of a 

ruler and are drawing around it. If you pull the cursor away from the edge, you can draw freely 

again, as we did at the end of the stroke in the image above.

The easiest way to follow the edge is to keep running the cursor along the inside of the object.



The red line in the image above shows where we ran the cursor to get the straight line. You don’t 

need a steady hand, because while the cursor is inside the object like that, the stroke sticks to the 

edge automatically.

In addition to sticking the stroke to the edge, when you have a Ruler mode object on your canvas it 

also prevents paint being applied underneath it. The result is that the ruler also acts like a Stencil.

In the image above, you can see that the paint stroke stuck to the edge of the item, and was also cut 

off underneath it. This can be very useful when you want to make precise curves with sharp edges, 

such as when using an airbrush.

Guide Mode.

When set to this mode, the item works like a guide for your brush, allowing you to ‘bump’ your tool 

against it like a ruler, but not preventing paint from going underneath it. It’s like a ruler that is sus-

pended above the canvas.

Items in Guide Mode are tinted blue.

Guides work like Rulers in that the stroke sticks to the edge as you paint. However, unlike Rulers, 

Guides do not stop paint going underneath their body, they just provide an edge to bump against as 

if they are raised above the surface of the canvas.



This Paint Roller stroke started to the left and was dragged in towards the upper edge of the Guide. 

The cursor was dragged along just inside the edge of the Guide and the stroke followed its curve.

You don’t have to be too accurate once the stroke is stuck to the guide, just follow the curve roughly 

and the stroke will follow it precisely. If you continue to drag off the guide and away from it (up-

wards, in this case, to move away from the edge my tool is ‘bumping’ against) the stroke will move 

with you and unlock from the edge.

Transparent Stencils.

Stencils can have holes in them, just like their real world counterparts. However, unlike their real 

world counterparts, Stencils in ArtRage can be partially transparent. This means that you can create 

a Stencil that fades from completely transparent to completely solid, which allows you to create 

subtle gradients of paint as you apply.

When a Stencil is partially transparent, only some of the paint you apply will get through to the sur-

face underneath.



The Stencil above has three holes with different levels of transparency, from 25% transparent on the 

left, to 100% transparent on the right.

Tip: You can use a photograph as a Stencil in this manner to create painted effects.

The light and shadow of the image let paint through at different rates, so the look of the photograph 

is recreated underneath the Stencil.

For information on how to load a photograph in as a Stencil, see ‘Loading a Stencil From Disk’ 

later in this manual.



Using Stencils and Rulers.

The Stencil Picker.

Stencils and Rulers are accessed from the Stencil Picker, which can be opened by clicking the Sten-

cils button on the Toolbox Panel which sits at the bottom edge of the ArtRage window. Using this 

picker you can add new Stencils and Rulers to the canvas, and manipulate the items you have al-

ready added.

Down the left side of the Stencil Picker you will see a set of categories that contain Stencils of vari-

ous types.

The Active category contains a list of all the Stencils you currently have on your canvas. The Favor-

ites category contains a list of the last 10 Stencils you added, so that you can find them again 

quickly.

Beneath those two categories is a list of Stencils that you can add to the canvas. These Stencils are 

stored in the ArtRage Resources folder.

The Stencil Picker can be resized vertically. Click and drag the grips at the bottom corners.

To move the Stencil Picker, click and drag the green grip at the top. To close it, click the X button at 

the top right.

The Menu button at the top left of the Stencil Picker gives options for creating new categories, add-

ing Stencils, and working with Stencils you already have on the canvas.



Adding Stencils and Rulers.

Stencils and Rulers can be added by opening the appropriate category in the Stencil Picker and 

clicking the Stencil you wish to add. The Stencil will appear on the canvas.

Notice that the Stencil can overlap the edge of the Canvas.

If you prefer, you can click and drag the Stencil from the Stencil Picker. If you do this, the Stencil 

Picker and all other interface items vanish and you can continue dragging to position it. When you 

release the mouse button, the interface will reappear.

Moving, Scaling, and Rotating Stencils.

Stencils can be moved, scaled, and rotated on the canvas. There are a number of ways to do this:

• The Move, Scale, and Rotate tools found on the Toolbox Panel at the bottom of the ArtRage Win-

dow will work with Stencils if you click and drag them rather than the canvas.

• Right clicking and dragging a Stencil will move it. While dragging, hold down Alt/Option to scale 

it, or Ctrl/Cmd to rotate it.

• Holding down the Space Bar and dragging a Stencil will move it.

When Stencils are Moved, Scaled or Rotated, a pin appears in them.



This pin indicates the ‘center’ of the Stencil. When you scale the Stencil, it scales outwards from the 

center. When you rotate it, it rotates around the center. To change the centre of the Stencil, just pick 

up the pin by its head and stick it in the center point. The point where the pin sticks in to the surface 

is the center.

Think of the pin like a finger placed on a ruler to hold it in place while you rotate the other end.

The pin will fade out after a short time so that it doesn’t get in the way of painting. You can bring it 

back by right clicking the Stencil, or selecting the Move, Scale, or Rotate tools from the Toolbox 

and hovering the mouse over the top of it.

The Ruler.

The Ruler is a special Stencil available from the ‘Rulers’ category in the Stencil Picker. The Ruler 

can be used like any other Stencil, in any of the three modes, but has additional functionality.

• If you click and drag on the green handles at each end, the ruler rotates and stretches to follow the 

cursor. Remember that it will rotate around the area of its pin.

• The ruler displays the distance along its length in pixels and whichever measurement unit you 

have selected when creating the size of your document.



Managing Your Active Stencils.

The Active category in the Stencil Picker contains a list of all the Stencils you currently have on the 

canvas.

Clicking the thumbnail for one of your Stencils flashes it on the canvas and brings it to the top so 

that you can work with it. Clicking the Hide or Show button hides or shows the Stencil.

Clicking the Menu arrow underneath a Stencil’s thumbnail brings up the menu for that Stencil (right 

clicking the Stencil itself on the canvas also does this). The menu contains the following options:

• Stencil Mode: Puts the Stencil in to Stencil Mode (see ‘Stencils and Rulers’ earlier in this man-

ual).

• Ruler Mode: Puts the Stencil in to Ruler Mode (see ‘Stencils and Rulers’ earlier in this manual).

• Guide Mode: Puts the Stencil in to Guide Mode (see ‘Stencils and Rulers’ earlier in this manual).

• Flip the Stencil Horizontally: Flips the Stencil horizontally. This does not change any other 

Stencils of the same type that you have on your canvas.

• Flip the Stencil Vertically: Flips the Stencil vertically. This does not change any other Stencils of 

the same type that you have on your canvas.

• Invert the Stencil: Inverts the Stencil, so that holes it become solid and vice versa. This does not 

change any other Stencils of the same type that you have on your canvas.

• Save Stencil Image to Disk: Saves the Stencil out to disk for use in other paintings. See ‘Making 

and Saving Stencils’, later in this manual.

• Hide Stencil: Hides or shows the Stencil on the canvas.

• Remove This Stencil: Removes the Stencil from the canvas.



Making and Saving Stencils.

As well as adding Stencils from the Stencil Picker, you can make new ones in ArtRage, or load 

them from Disk.

When you save a painting, any Stencils you had open on the canvas are saved with it. If you send 

that painting to a friend, they can see all the Stencils you used even if they did not have them be-

fore. But to re-use them in other paintings they will need to Save them to disk. See ‘Making and 

Saving a Stencil From a Layer’ below.

Loading a Stencil From Disk.

To load a Stencil from Disk you can either add it directly to a category, or load it temporarily. A 

Stencil that is added to a category will be available when you next start ArtRage. A Stencil that is 

just loaded from Disk will only be available in the painting you loaded it for.

To Load a Stencil from Disk, go to the Stencil Picker and use the menu at the top left of the panel. 

In that menu, you can select Load Stencil From Disk and a file picker will open for you to load the 

Stencil.

To add a stencil from to a category, go to the Stencil Picker, select the category you would like to 

add the Stencil to, and click the Add New Stencil button. When you do this, you are prompted to 

select an image to use as the Stencil.

When you load an image, the light areas in it will be made in to solid areas of the Stencil, and the 

dark areas will be made in to holes. Any areas that are between black and white will be made semi 

transparent.

Tip: If you’re making Stencil images, make them pretty large. The larger they are, the better quality 

they will be when you scale them up. For examples, look in the ArtRage Resources folder under 

‘Stencils’. We suggest using a loss-less image format such as PNG.



Making and Saving a Stencil From a Layer.

If you have added paint to a Layer, you can convert it in to a Stencil. Just go to the Layers Menu in 

the Tools Menu, or click the Menu button for the Layer you wish to use in the Layer Panel and se-

lect ‘Make a Stencil From this Layer.’

When you do this, a new Stencil will appear on the canvas with cutouts in the shape of the paint you 

converted.

This Stencil will appear in the Active category of the Stencil Picker but will not be saved to disk. 

This means that you won’t be able to get access to it from any other paintings, and if you remove it 

from the canvas you won’t be able to get it back without recreating it.

To solve this, you need to save the Stencil. The right click menu for the Stencil, or the menu button 

for its entry in the Active category of the Stencil Picker contains a Save option that allows you to do 

this.

When you select it, you are prompted for a file name and a location to save. The Stencil Picker finds 

Stencils that are saved in the ArtRage ‘Resources’ folder inside the ‘Stencils’ folder. If you save the 

Stencil directly in to the Stencils folder it will appear in the Stencils category next time you open 

the Stencil Picker. If you save it in to any folder inside the Stencils folder, it will appear in a cate-

gory of that name next time you open the Stencil Picker.

This allows you to store your Stencils for use in other paintings.



Shortcut Keys.

Menus.

Open"" " " " " " " " " Ctrl/Cmd + O

Save" " " " " " " " " " Ctrl/Cmd + S

Import" " " " " " " " " Ctrl/Cmd + I

Export" " " " " " " " " Ctrl/Cmd + E

Print" " " " " " " " " " Ctrl/Cmd + P

Quit" " " " " " " " " " Ctrl/Cmd + Q

Undo"" " " " " " " " " Ctrl/Cmd + Z

Redo"" " " " " " " " " Ctrl/Cmd + Y

Copy Layer To Clipboard" " " " " " Ctrl/Cmd + C

Paste Clipboard To New Layer" " " " " Ctrl/Cmd + V

Load Tracing Image" " " " " " " Ctrl/Cmd + T

Show/Hide Tracing Image" " " " " " T

Load Reference Image" " " " " " " Ctrl/Cmd + R

New Layer"" " " " " " " " Ctrl/Cmd + L

Show Manual (Windows)" " " " " " F1

Show Manual (OSX)" " " " " " " help

Check For Updates Online" " " " " " Ctrl/Cmd + U

About ArtRage 2"" " " " " " " Ctrl/Cmd + !

Tools.

Oil Paint" " " " " " " " " 1

Pencils" " " " " " " " " 2

Palette Knife" " " " " " " " 3

Airbrush" " " " " " " " " 4

Chalks" " " " " " " " " 5

Glitter Gun"" " " " " " " " 6

Paint Roller" " " " " " " " 7

Paint Tube" " " " " " " " " 8

Color Sampler" " " " " " " " 9

Felt Pens" " " " " " " " " 0

Crayons" " " " " " " " " -

Eraser" " " " " " " " " =

Canvas Mover" " " " " " " " M

Canvas Rotater" " " " " " " " R

Canvas Zoomer" " " " " " " " Z

General.

Sample Color" " " " " " " " Alt/Option + Left Click

Show/Hide All Panels" " " " " " " Tab

Show/Hide All Interface" " " " " " Enter / Right Click

Show/Hide Tracing Image" " " " " " T



Show/Hide Stencils and Rulers" " " " " F

Show/Hide Color Samples" " " " " " S

Increase Tool Size 1%" " " " " " " Right Arrow

Decrease Tool Size 1%"" " " " " " Left Arrow

Increase Tool Pressure 1%" " " " " " Up Arrow

Decrease Tool Pressure 1%" " " " " " Down Arrow

Increase Tool Size 10%"" " " " " " Shift + Right Arrow

Decrease Tool Size 10%" " " " " " Shift + Left Arrow

Increase Tool Pressure 10%" " " " " " Shift + Up Arrow

Decrease Tool Pressure 10%" " " " " " Shift + Down Arrow

Select Next Layer" " " " " " " Ctrl/Cmd + Up Arrow

Select Previous Layer" " " " " " " Ctrl/Cmd + Down Arrow

Zoom In" " " " " " " " " Ctrl + +

Zoom Out" " " " " " " " " Ctrl + -

Drag the Canvas" " " " " " " " Right Click Drag

" " " " " " " " " " Space + Left Click Drag

Rotate the Canvas" " " " " " " Alt/Option + Right Click Drag

" " " " " " " " " " Space + Alt/Option + Left Click Drag

Zoom In To or Out Of the Canvas" " " " " Shift + Right Click Drag

" " " " " " " " " " Space + Shift + Left Click Drag

Rotate Canvas 180 Degrees" " " " " " /

Quick Mirror the Canvas Horizontally" " " " Hold Down H

Quick Mirror the Canvas Vertically"" " " " Hold Down V

Reset Canvas to Default Position, Scale, and Rotation" D
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